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Chapter Contents
Overview

Chapter 1 Software Description

Software that Enables the Field Configuration of Banner I0-Link Masters and Banner O-Link Devices

» Allows the configuration of Banner |0-Link devices

* Free to download and available on the product pages for
the DXMR110-8K, DXMR90-4K, R90C-4K-MQ, and R45C-2K-MQ I0-
Link masters

+ Works on Microsoft® Windows® 7 and 10"

* BWA-UCT-900 or Ethernet cable required to connect PC-based 10-
Link Configuration Software to Banner IO-Link masters and Banner
IO-Link devices, depending on which Banner |0-Link master you are
using

NOTE: Administrative rights are required to install the 10-
Link Configuration Software.

Overview

Banner's 10-Link Configuration Software offers an easy way to configure Banner 10-Link masters and Banner 10-Link
devices, offering users full control of master and device configuration. The easy-to-use software provides a variety of tools
and works with the DXMR110-8K, DXMR90-4K, R90C-4K-MQ, and R45C-2K-MQ |O-Link masters.

Configure Banner 10-Link masters and Banner IO-Link devices using the free 10-Link Configuration Software, available for
download at https://www.bannerengineering.com/us/en/products/software/io-link-software.html.

(™ Microsoft and Windows are registered trademarks of Microsoft Corporation in the United States and/or other countries.
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Chapter 2 Specifications and Requirements

|O-Link Configuration Software PC Requirements

Operating System USB
Microsoft® Windows® operating system versions 7 or 10" Available USB port
Hard Drive Space Screen Resolution
120 MB 1366 x 768 full-color minimum
() Microsoft® and Windows® are registered trademarks of Microsoft® Third-Party Software
Corporation in the United States and/or other countries. .NET version 4.6.2 or higher

IMPORTANT: Administrative rights are required to install the I0-Link Configuration Software.

Adapter Cable — Required for use with Serial 10-Link Masters

An adapter cable, model BWA-UCT-900, is required for use with the 10-Link Configuration Software, Banner R90C-4K-MQ,
and Banner R45C-2K-MQ serial IO-Link masters. Use the adapter cable to connect Banner serial 10-Link devices to read,
write, and preview device configurations.

) H::Oﬁ » Connects Banner serial 10-Link masters to the PC-based |0-Link
@i Y Configuration Software
. .

Model
Model Adapter Length Connections
BWA-UCT-900 RS-485 to USB 1 m (3.28 ft) USB and 5-pin M12 quick disconnect

BWA-UCT-900 Adapter Cable Specifications

Input Voltage Output Voltage
5V DC from USB Type A connector 24 V DC power output for a single device transmitting at 1
A Watt
Certifications
Operating Conditions
C € —40 °C to +80 °C (—40 °F to +176 °F)

95% maximum relative humidity (non-condensing)

September 19, 2023 © Banner Engineering Corp. All rights reserved.
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Ethernet Cordset — Required for use with Ethernet |O-Link
Masters

An Ethernet cordset is required for use with the IO-Link Configuration Software, Banner DXMR110-8K, and Banner
DXMR90-4K IO-Link masters with an Ethernet IP interface. Use an M12 to RJ45 Ethernet cordset to connect to Banner
Ethernet |O-Link masters to read, write, and preview device configurations.

RJ45

r47.4 Typ.i » Connects Banner Ethernet 10-Link masters to the PC-based 10-

Link Configuration Software
M12x1.0 —~

2 14.5—

Models

Model Adapter Lengths Connections

1.83 m (6 ft)
STP-M12D-4xx M12 D-code to RJ45 4.57 m (15 ft) Ethernet and 4-pin M12 quick disconnect
Shielded Ethernet
9.14 m (30 ft)

FCC Part 15 Class B

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the
FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee
that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct
the interference by one or more of the following measures:

» Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

« Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

» Consult the dealer or an experienced radio/TV technician for help.

Industry Canada ICES-003(B)

This device complies with CAN ICES-3 (B)/NMB-3(B). Operation is subject to the following two conditions: 1) This device
may not cause harmful interference; and 2) This device must accept any interference received, including interference that
may cause undesired operation.

Cet appareil est conforme a la norme NMB-3(B). Le fonctionnement est soumis aux deux conditions suivantes : (1) ce
dispositif ne peut pas occasionner d'interférences, et (2) il doit tolérer toute interférence, y compris celles susceptibles de
provoquer un fonctionnement non souhaité du dispositif.

© Banner Engineering Corp. All rights reserved. September 19, 2023
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Chapter 3 Installation Instructions

Install the Software

IMPORTANT: Administrative rights are required to install the 10-Link Configuration Software.

[N

. Download the latest version of the software from https://www.bannerengineering.com/us/en/products/software/io-link-
software.html.

. Navigate to the downloaded file IOLConfigInstaller.exe.

. Double-click the installer to open Banner 10-Link Configuration Software Setup.

. Accept the terms in the License Agreement by selecting the checkbox.

. Click Install to install the software.

. Depending on the system settings, a pop-up window may appear prompting to allow the 10-Link Configuration
Software to make changes to the computer. Click Yes.

. Click Close to exit the installer after installation is complete.

N OO WN

Connect the Cables

For serial |O-Link masters:
1. With the BWA-UCT-900 adapter cable, plug the M12 connector into male connector of the 10-Link master.
2. Plug the USB connector of the BWA-UCT-900 into the PC.
3. Plug the power cable of the BWA-UCT-900 into a wall outlet.

For Ethernet 10-Link masters:

1. With an Ethernet cordset, plug the M12 connector into the male connector of the IO-Link Master.
2. Plug the RJ45 connector of the Ethernet cordset into the PC.

Connect an |0O-Link Device with a Cable

To connect Banner 10-Link devices:

1. Connect the Banner IO-Link device or devices to the ports on the 10-Link masters using an M12 cordset.
2. Plug the applicable accessory into the 10-Link master:
a. For serial 10-Link masters: Use the BWA-UCT-900 adapter cable, and plug the female M12 connector into the
male M12 communication port on the serial |IO-Link master.
b. For Ethernet 10-Link masters: Use an Ethernet cordset, and plug the male M12 connector into the female M12
D-code Ethernet port on the Ethernet |O-Link master.
3. Plug the USB or RJ45 connector into the PC.

September 19, 2023 © Banner Engineering Corp. All rights reserved.
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Example - Serial I0O-Link Master Device Connection

@ IO-Link

Banner
Device

1UAV)]

BWA-UCT-900 Adapter Cable

Serial 10-Link Master (Ex. R45C-2K-MQ)
PC Running 10-Link Configuration Software
M12 Cordset (Ex. MQDEC-401SS)

Banner 10-Link Device

moow>

Q10-Unk’

<

b
Load an |O-Link Device IODD

After connecting a Banner IO-Link master to a PC, use one of these methods to connect 10-Link devices to the 10-Link
Configuration Software.

Use the I0ODD Finder
Use the software to scan the connected device to download and install the IODD files automatically.

Use this method if there is not an 10DD file already downloaded onto the PC. See "Add the IODD File Manually" on page 9.
1. Click Connect on the |0-Link Configuration Software start page.

Connect the 10-Link master

Fle Home log  Help
> Load I0DD © Exit

10-Link Configuration Software
<

@ IO-Link®

BANNER

For use with R4SC.RSOC and DXNRS0 10-Uink Master Devices

@ Not Connected

An IODD Not Loaded pop-up window appears when the 10-Link device is connected successfully.
2. Select Search for IODD(s) on IODD Finder.

© Banner Engineering Corp. All rights reserved. September 19, 2023



[O-Link Configuration Software Instruction Manual

IMPORTANT: An internet connection on the PC is required for this functionality.

10DD Finder

Fle Home Device log Help
 Load IODD © Exit
DXMRI10-8K | R4SCKIMIQ(3)  S1SC-MGN-KQ(7)
General
Vendor Info
Port Setup
Vender Banner Engineering Corporation
10-Link § @ 10D Not Loaded

Product Info
10DD(s) not loaded for connected device(s):

S15C-MGN-KQ

Descripti

Revision|

Master

i Search for I0DD(s} on 10DD Finder
Cancel

“Intemet connection required for search to work

10-Link Master: DXMR110-8 Connected

A Load Successful pop-up window appears when the IODD file is installed successfully. Click OK to close.

Load Successful
File  Home Device  Log Help

2 Load I0DD @ Exit

8K | RASCKIMIQE)  ST5C-MGN-KQ (7)

General
Vendor Info
Port Setup

Product Info %

@ oreeoovoriess

fully for device SISCMGNKQ  heom)

-

10-Link Master: DXMR110-8K Connected

Add the 10DD File Manually

1. Download the Banner I0-Link device IODDs manually.
a. Go to www.bannerengineering.com.

You can also go to ttps://ioddfinder.io-link.com/ to search and download device |ODDs.

b. Search for the desired Banner |0O-Link devices.
c. Click Product Detail.

Search for the Product (LM150KIQP shown)

BANNER'S CALL FOR PARTS CREATES A STEADY WORKFLOW AND FINFOINTS CRITICAL ISSUES. LEARN MORE

SEN  HowToBy @ MyAcoun g Cont Q Gentast s

@ INDUSTRIES PRODUCTS APPLICATIGNS SUPPORT COMPANY

@ Add 1o My Library

Search Results For "LM150KIQP"

NARROW RESULTS
| . LM1SOKIQP (803940)
g,g
) ¥ R

Proguct Dacs

PRODUCT

d. On the product page, under Downloads, navigate to the IODD file and click the download button.

September 19, 2023 © Banner Engineering Corp. All rights reserved.
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Download the I0DD Files
PRODUCT DATA FILES DAt rwre fize /
o LM80 AND LM150 . . fo e - P
10DD FILES

2. Extract the downloaded I0DD zip file and save it to a desired location.
Repeat this process for every Banner |0-Link device that is connected to the 10-Link master.
3. Open the 10-Link Configuration Software and click File > Load IODD in the upper left corner of the window.

Load IODD

\ 10-Link Configuration Software

@ IO-Link®

BANNER

2 o i RAIC a2 O Kk M D

@ crcomcrs 1l
A File Explorer window opens.
4. Navigate to where the I0DD file was extracted to in File Explorer and click on it.
5. Click Open in File Explorer.
Open the 10DD File
1 @

@ Not Connectes

The file explorer window closes, and the IODD file loads into the 10-Link Configuration Software.

Connect to the Software

Connect a Serial |O-Link Master
1. Click Connect on the |0-Link Configuration Software start page.

© Banner Engineering Corp. All rights reserved. September 19, 2023
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Connect the Device

File Home log  Help
2 Load I0DD @ Exit

10-Link Configuration Software
<

@ IO-Link®

3
BANNER

RASC RI0C and DXRSD

@ Not Connected

2. In the pop-up window, select Serial, and then click Connect.

Select Serial

File  Home log  Help
2 Load 0D © Exit

10-Link Configuration Software

Ethemet
Comm Port: | COM3. ~[e

BaudRate: | 19200 -

Parity None

Cancel

3
BANNER

o uee uith RASC. RSO and DXVRGD 10-Unk Vst Diviess

@ Not Connected

The Banner I0-Link master and devices are now connected to the 10-Link Configuration Software. The connected 10-Link
devices appear in new tabs within the software window, and the status in the bottom right corner now reads as Connected.

Serial Connected

Fle Home log  Help
* Load I0DD @ Exit

RISC | LESSOKQP (2 &

General
Vendor Info
Port Setup
Vendor Banner Engineering Corporation

10-Link Vendor D |451
Product Info

Product Name. Rd5C

Description 2 Port IOL Master (www.bannerengineering.com/io-link)
Revision 7

Master ID 210585

FW Revision 2

10-Link Master: RASC @ Connected

Connect an Ethernet |1O-Link Master
1. Click Connect on the 10-Link Configuration Software start page.

September 19, 2023 © Banner Engineering Corp. All rights reserved.
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File

Connect the Device
Home  Log Help

2 Load I0DD @ Exit

10-Link Configuration Software
<

@ IO-Link®

BANI\TI:R

2. In the Connect window, select Ethernet, and click Scan.

@ Not Connected

File  Home

Select Ethernet

? 10ad I0DD @ Bxit

10-Link Configuration Software

@ connect .. V o x

Serial @ Ethernet

®
Sean

Scan ‘

1P Addr:

Port®

Cancel

DRANNER ]

uith RASC. RSOC and DXMRSD 0-Link Mstar D

@ Not Connected

When the scan is complete, a new pop-up window appears.

3. In the new pop-up window, select the subnet the 10-Link master is connected to from the drop-down menu, and
click Go.

File  Home

Select Subnet

# Load I0ED € Exit

10-Link Configuration Software

@ Scan fora Device

o X%

10.10.15.%
169.254.1%
160.2542%
169.254.3.%
192.168.0.*

'3
BANNER

2wt ASC RSOC snc DYVRSD O-ink Vs Davics:

@ Not Connected

The model number and the IP addresses of the connected Ethernet 10-Link masters are displayed
4. Select the IP address of the |O-Link master to connect to, and click Confirm.

© Banner Engineering Corp. All rights reserved.
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Select IP Address and Model Number

Fle Home log  Help &

¥ Load 10DD @ Exit

10-Link Configuration Software
@ scan fora Device - o x

3
BANNER

For use with R4SC. RS0C and DXS0 10-Lnk MasterDevices

@ Not Connected

The pop-up window closes, and the IP address of the connected 10-Link master auto-fills in the Connect window.
5. Click Connect to connect to the 10-Link master.

Connect Ethernet

Fle Home log  Help

$L0ad I0DD @ Exit

10-Link Configuration Software

@ comnectt.. — O X

Serial ® Ethemet
Scan Scan

1P Addr: 19216803
Port# 344

Cancel Connect

BANI\TER

For use with RASC. RSOC and DHRED I0-Link MasserDevicss

@ ot Connected

The Banner IO-Link master and devices are now connected to the |0-Link Configuration Software. The connected 10-Link
devices appear in new tabs within the software window, and the status in the bottom right corner now reads as Connected.

Ethernet Connected

File Home log  Help ~

¥ Load 10DD @ Bxit

DXMRII0-K | LESSOKQP (1) <—

General
Vendor Info
Fort Setup
Vendor : porat
10-Link Vendor ID | 451
Product Info
Product Name DXMR110-8K
Description 8 Port ICL Master (www.bannerengineering.com)
Revision 0
Master I 814332
FW Revision 1028
10-Link Master: DXMR110-8€ @ Connected

September 19, 2023 © Banner Engineering Corp. All rights reserved.
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Chapter 4 Configuration Instructions

Read and Change the Banner 10-Link Device Configuration

1. Select the device tab in the software window, and click Parameters in the left menu.

Parameters is used to read and change the Banner |O-Link device configuration. After clicking on Parameters, the
Parameters pane opens within the device tab.

Parameters

File Home Log  Help
> Load I0DD 9 Exit

RASC | K50ProFF/PB | LESSOKQP

at
arameters
Drag a column header here to group by that colum Q
Parameters Comman: d Name RW Val Cmd State Units

UsB: R45C Connected

2. Click Read Params to read the current configuration of the connected Banner 10-Link device.

Read Params

File Home log  Help
> Load 100D © Eit

RASC | KSOProFF/PB | LESSOKQP

RW val Crmd State Units

ustom Animation Settings

ustom Color 1 Configuration

ustom Color 2 Configuration

USB: R45C Connected

This displays the current 10-Link configuration information in the Parameters pane, along with all of the device's
available settings.

3. If desired, make any changes to the Banner IO-Link device's configuration in this pane using the available settings.
4. If changes were made to the settings, write the changes to the device by clicking Write Params.

September 19, 2023 © Banner Engineering Corp. All rights reserved.
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Process Data

Write Params

Fle Home log  Help
? Load I0DD @ Exit

RASC  LESSOKQP | K3

Process Data | | ReadParams | | Wrte Params <—

Parameters

Parameters ~

RW val Crmd State

rs: Custom Animation Settings
» Parameters: Custom Color 1 Configuration

» Parameters: Custom Color 2 Configuration

¥ Parameters: Device Access Locks
) Para S /

Demo

Output Settings Output St.. ™. Normally Closed
Output Settings Off Delay... | rw Leading Edge
Output Settings Off Delay... | rw 0

» Parameters: State 1 Parameters

» Parameters: State 2 Parameters

» Parameters: State 2 Parameters

UsB: R45C

Process data refers to the information that the device reads and transmits to the master, such as the distance reading on a

laser measurement sensor.

Process data can also refer to information that is transmitted to the device from the master, such as messages sent to a
tower light indicating which color segments should be illuminated.

Cyclic and acyclic process data can be transferred between an 10-Link master and an 10-Link device. By clicking Process
Data in the left menu, the user is able to view the live process data of the Banner 10-Link device connected to the 10-Link

master.

Process Data IN is data that is sent from the |O-Link device to the IO-Link master.

Process Data OUT is data that is sent from the 10-Link master to the 10-Link device.

Process Data

File Home log  Help
? Load IODD © Exit
RASC | K5O ProFF/PE | LESSOKQP

Process Data IN Process Data OUT

Name val Name val
Output State | 1 Job Input |

State | 2

Write

USB: R45C

© Banner Engineering Corp. All rights reserved.
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Read and Change the Banner 10-Link Master Port
Configuration

The |0-Link Configuration Software has a special tab for configuring the port settings on the 10-Link master. To access, click
on the I0-Link master tab and select PortSetup.

10-Link Master Port Setup

File Home log  Help
2 Load I0DD @ Exit
ROOC | KSOProFF/PB  LESSOKQP  SISC-U  S1SC-U

Port 1 Port 2 Port3 Port 4

10L AUTOSTART ~| 1oL AUTOSTART | |ioLauTosTART = [1oLAuTOSTART
DEACTIVATE

10L Manual

10L AUTOSTART 251

bic/a

393220 327681 poc/Q 659470

251 451

Digital Input ~| | Disabled v |Disabled | [Disabled

Normal ~ Diagnostic nput ~ | Diagnostic Input = [Normal

Read Write Read Wiite Read Wiite Read Write

UsE: R9OC Connected

The operating mode can be configured for any port on the IO-Link master. The following modes can be used:

Deactivated
Use deactivated mode for any unused 10-link master ports if a device is not connected.

I0-Link Manual
The 10-Link master only connects 10-Link devices that have a certain vendor ID and device ID (1: IOL_MANUAL).

I0-Link Autostart
The 10-Link master connects to every connected I0-Link device (2: IOL_AUTOSTART).

Digital Input
The 10-Link port functions as a standard digital input (3: DI_C/Q).

Digital Output
The 10-Link port functions as a standard digital output (4: DO_C/Q).

When the backup function of the IO-Link master is used, the IO-Link master automatically provides the saved parameters to
the new device after replacement. This makes IO-Link device replacement seamless in I10-Link applications. Another
common industry term for this function is data storage mode.

. Backup+Restore Mode

If a port on the 10-Link master is set to Backup+Restore, then the new device added to the IO-Link port takes in the
same device configuration as the device that was just replaced, as the 10-Link master had stored the last configuration
change by a backup (3: Type compatible Device V1.1, Backup + Restore).

. Restore

If the port on the 10-Link master port is set to Restore, then the new device takes in the configuration according the
settings saved in the master at the time of the last backup. Because possible configuration changes were not saved in
the master, a different behavior from the previous one before the replacement may occur (4: Type compatible Device

V1.1, Restore).

Make changes to the ports' settings by selecting the drop-down menus for each port. To read the current configuration of
each port, select the applicable Read button. After making the desired changes to the port settings, select the
applicable Write button.
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Write Port Settings
File  Home Log  Help ~
Tmad 10DD € Exit
RIOC K50 Pro FF/PB LESS0KQP S15C-U $15C-U
General
PortSetup Param Name Port 1 Port 2 Port 3 Port4
ppppppp e ) Y e ) T 7] (oo
Fort Cycle Time 0 0 0
\Vendor ID 451 451 451
Device ID 393220 327681 659465

10 8ehavior Digital Input ~| | Disabled
Input Type Normal ~| | Diagnostic Input
Read Write Read Write

Change the IP Address on the DXMR90-4K and DXMR110-8K
|O-Link Masters

1. Click Device » IP Settings.

Navigating to Device > IP Settings

ﬁla—uam} Device  Log Help

@ IP Settings

CXMR| K

General
Vendor Info
Port Setu

Vendor Bar
10-Link Vendor ID 45
— Product Info

Product Name DX
Description &p
Revision 0

Master ID 81
FW Revision 100

2. In the pop-up window, select Static IP, DHCP, or Follow DXM XML Settings from the drop-down menu.
3. Enter the desired IP address settings, and click Change IP Settings.

Changing IP Address Settings
@ P Settings — O ¥

——P ststic P -

Mew IP Address: | 192.168.0.4
Subnet: |255.255.255.0
Gateway: |0.0.0.0

Change IP Settings (—
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Change the Server ID on the R90C-4K-MQ and R45C-2K-MQ
|O-Link Masters

Connect the R45C-2K-MQ or R90C-4K-MQ to the PC, and then to the I10-Link Configuration Software (see "Connect the
Cables" on page 7 and "Connect to the Software" on page 10). A pop-up window appears after clicking “Connect.”

1. Select Serial.
2. Click Find.

Identifying the Current Server ID

Fle Home log Help
> Load I0DD @ Exit

10-Link Configuration Software

Comm Port; | COM7

Baud Rate: | 19200

Parity None

s with RASC:2KCMCL RS0-4K-MO, DRSS anh DXMIIT03€10-Link Masear Devices

@ Not Connected

The software displays the current server ID of the connected 10-Link master.
3. Change the server ID of the IO-Link master by using the up and down arrows.
4. Click Set to apply the new server ID to the 10-Link master.

Changing the Server ID

@ et Conneced

A pop-up window displays that the server ID change was implemented successfully. Click OK to close.

September 19, 2023 © Banner Engineering Corp. Al rights reserved.



IO-Link Configuration Software Instruction Manual

Server ID Updated Successfully

File Home log  Help

> L0ad I0DD. @ Eit

10-Link Configuration Software

® Serial Ethernet

Update Successful

3
BANNER

For s inh RASC26-MQ, R90-4MQ, DXVRDD-4K and DIOARTT0-BK 0-Lin Meister Dices.

@ Not Connected
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Chapter Contents
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Chapter 5 Accessories

|O-Link Hardware

4-Pin Threaded M12 RS-485 to USB Adapter Cordset, with Wall Plug

Model Length Style Dimensions Pinout (Female)
2 4
. _— 1 3
BWA-UCT-900 1 m (3.28 ft) Straight LT
i 1 =Brown
: .Y 2 = White
3 =Blue
4 = Black

4-pin M12 D-code to RJ45 Shielded Ethernet

Model Length Style Dimensions Pinout (Male)
STP-M12D-406 1.83 m (6 ft)
STP-M12D415 4.57 m (15 ft)
1 = White/Orange
RJ45 2 = Orange
3 = White/Blue
6 = Blue
Straight T‘* 474 Typ-l
STP-M12D-430 9.14 m (30 ft) { ] 2 1
M12x 1.0 3 4
2145~
1 = White/Orange
2 = White/Blue
3 = Orange
4 = Blue
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10-Link Configuration Release Notes
COoNtACT US ..o
Banner Engineering Corp Limited Warranty

Chapter 6 Product Support and Maintenance

Maintenance

Maintenance tasks include updating the 1O-Link Configuration Software as new versions become available.

Update the Software
The current version of the IO-Link Configuration Software is available for download from https://www.bannerengineering.com/
us/en/products/part.811445.html.

When connected to a network, if a 10-Link Configuration Software update is available, a red icon B displays in the bottom
right corner of the 10-Link Configuration Software. Click this icon to update the software to the latest version.

|O-Link Configuration Release Notes

Version Devices General
2.0.37 Added support for setting the server ID on serial 10-Link 10DD Finder API support for automatic searching and downloading of
o masters R90-4K-MQ and R45C-2K-MQ 10DDs
Added support for DXMR110-8K |0-Link Master, Ethernet DXMR90-4K and DXMR110-8K can connect via Ethernet, and IP
2.0.29 ! - - . ; ; ;
connectivity, and IP addressing functionality addressing functionality added
2.0.7 Added support for DXMR90-4K 10-Link Master Can now connect multiple devices and configure multiple ports
1.0.16 Supports R45C and R90C |0-Link Master devices Initial release

Contact Us

Banner Engineering Corp. headquarters is located at: 9714 Tenth Avenue North | Minneapolis, MN 55441, USA | Phone: + 1
888 373 6767

For worldwide locations and local representatives, visit www.bannerengineering.com.

Banner Engineering Corp Limited Warranty

Banner Engineering Corp. warrants its products to be free from defects in material and workmanship for one year following
the date of shipment. Banner Engineering Corp. will repair or replace, free of charge, any product of its manufacture which, at
the time it is returned to the factory, is found to have been defective during the warranty period. This warranty does not cover
damage or liability for misuse, abuse, or the improper application or installation of the Banner product.

THIS LIMITED WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES WHETHER EXPRESS OR
IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FORA
PARTICULAR PURPOSE), AND WHETHER ARISING UNDER COURSE OF PERFORMANCE, COURSE OF DEALING OR
TRADE USAGE.

This Warranty is exclusive and limited to repair or, at the discretion of Banner Engineering Corp., replacement. IN NO
EVENT SHALL BANNER ENGINEERING CORP. BE LIABLE TO BUYER OR ANY OTHER PERSON OR ENTITY FOR ANY
EXTRA COSTS, EXPENSES, LOSSES, LOSS OF PROFITS, OR ANY INCIDENTAL, CONSEQUENTIAL OR SPECIAL
DAMAGES RESULTING FROM ANY PRODUCT DEFECT OR FROM THE USE OR INABILITY TO USE THE PRODUCT,
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WHETHER ARISING IN CONTRACT OR WARRANTY, STATUTE, TORT, STRICT LIABILITY, NEGLIGENCE, OR
OTHERWISE.

Banner Engineering Corp. reserves the right to change, modify or improve the design of the product without assuming any
obligations or liabilities relating to any product previously manufactured by Banner Engineering Corp. Any misuse, abuse, or
improper application or installation of this product or use of the product for personal protection applications when the product
is identified as not intended for such purposes will void the product warranty. Any modifications to this product without prior
express approval by Banner Engineering Corp will void the product warranties. All specifications published in this document
are subject to change; Banner reserves the right to modify product specifications or update documentation at any time.
Specifications and product information in English supersede that which is provided in any other language. For the most
recent version of any documentation, refer to: www.bannerengineering.com.

For patent information, see www.bannerengineering.com/patents.

Banner Engineering Corp. Software Copyright Notice
© Banner Engineering Corp., All Rights Reserved.

https://www.bannerengineering.com/us/en/company/terms-and-conditions.html

Disclaimer of Warranties. This software is provided "AS-IS." To the maximum extent permitted by applicable law, Banner, it
affiliates, and its channel partners disclaim all warranties, expressed or implied, including any warranty that the software is fit
for a particular purpose, title, merchantability, data loss, non-interference with or non-infringement of any intellectual property
rights, or the accuracy, reliability, quality or content in or linked to the services. Banner and its affiliates and channel partners
do not warrant that the services are secure, free from bugs, viruses, interruption, errors, theft or destruction. If the exclusions
for implied warranties do not apply to you, any implied warranties are limited to 60 days from the date of first use of this
software.

Limitation of Liability and Indemnity. Banner, its affiliates and channel partners are not liable for indirect, special, incidental,
punitive or consequential damages, damages relating to corruption, security, loss or theft of data, viruses, spyware, loss of
business, revenue, profits, or investment, or use of software or hardware that does not meet Banner minimum systems
requirements. The above limitations apply even if Banner and its affiliates and channel partners have been advised of the
possibility of such damages. This Agreement sets forth the entire liability of Banner, its affiliates and your exclusive remedy
with respect to the software use.
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